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NOTICES 
 

Use and Copying of H-DRILL and Documentation 

Program H-DRILL and associated documentation are provided under a license 
agreement.  They may only be copied and used in accordance with the terms of the license 
agreement.  It is against copyright laws to use the program or documentation in a way not 
permitted by the license agreement or to copy the program or documentation in any way except 
for archival or backup purposes.   

 

Disclaimer of Liability 

     The author makes no expressed or implied warranty of any kind with regard to 
computer program H-DRILL or any associated documentation.  The information provided by the 
computer program should not be relied upon for any purpose without competent, professional 
examination and verification of its suitability by a licensed Professional Engineer.  This 
examination should include identification and understanding of any limitations of the program 
that may create adverse effects.  In no event shall the author be liable for incidental or 
consequential damages in connection with, or arising out of, the furnishing, performance or use 
of program H-DRILL or any associated documentation.   

The author requests to be informed of any suspected incorrect operation of H-DRILL.  
He also welcomes any suggestions for improvements to the program.   

 

Calibration Coefficients used by H-DRILL 

The calibration coefficients ā and b̄ used by H-DRILL v.2+ conform to the values given 
in ASTM Standard Test Method E837-99.  These values differ slightly from those given in 
earlier editions of E837, in previous versions of H-DRILL, and in other publications [8].  The 
new coefficients are based on the detailed geometry of the individual grids in the various strain 
gage rosettes [9].  Previous values of the coefficients were determined by uniform strain 
averaging over the area of each strain gage.  The new calibration coefficients should be more 
accurate than the previous values because they derive from more realistic physical modeling.  
Typically, the new values are about 1-2% higher than the previous coefficients, 4-5% in extreme 
cases.  Thus, H-DRILL v.2+ gives calculated residual stresses about 1-2% lower than previous 
versions of the program or other calculations based on previous ASTM coefficients.   
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1.  OVERVIEW 

1.1  Program Description 

H-DRILL is an interactive computer program that calculates residual stresses from strain 
measurements made by the hole-drilling method [1,2].  It does this calculation in two ways, the 
first assuming that the measured data are "exact", and the second allowing for the effects of 
experimental error in the measured data.  In the latter case, the program calculates the range that 
has a 90% probability of containing the actual stresses.   

H-DRILL uses a pull-down menu system to accept hole-drilling data in either US 
customary or metric units.  You may easily make additions or corrections to the data at any time.  
H-DRILL can also save the data to a file for subsequent retrieval and reuse.  The program 
calculates uniform and non-uniform residual stresses at the hole location.  You can display the 
calculated stresses either in numerical or graphical form, or save the results in a file.  H-DRILL 
also allows you to include strain data smoothing to reduce the effects of random measurement 
errors.   

 

1.2  Program Application Range 

H-DRILL follows the basic calculation procedures described in ASTM Standard Test 
Method E837-99 [1], with extensions for non-uniform residual stress calculations.  H-DRILL’s 
calculations apply to the following test conditions: 

• Hole-drilling rosette types specified in E837-99 

• Specimen width greater than 3 times the rosette mean diameter 

• Specimen thickness greater than 1.2 times the rosette mean diameter 

• Residual stresses smaller than 50% of the material yield stress 

Residual stress calculation accuracy deteriorates when the test conditions do not conform 
to the above specifications.  H-DRILL does not check to confirm that these geometrical or 
material limitations have been met.   

 

1.3  System Requirements 

• IBM PC computer or compatible. 

• Windows 95, NT or above.    
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1.4  Hole-Drilling Residual Stress Calculations 

The hole-drilling method is a convenient and effective method for measuring residual 
stresses.  The basic principle was first proposed by Mathar in 1934 [3].  Since that time, many 
researchers have further developed the method, culminating in the establishment of a 
standardized procedure ASTM  E837 [1].   

The original and most common objective of hole-drilling measurements is to evaluate 
in-plane residual stresses that can be assumed to be uniform either with depth from the surface of 
a thick specimen, or through the thickness of a thin specimen.  ASTM Standard Procedure E837 
refers to these cases.  In the “Through-Thickness” and “Uniform Stresses” options, H-DRILL 
follows the ASTM procedures.   

In many cases, residual stresses are not uniform with depth from the specimen surface.  
For example, a shot-peened material has high compressive stresses close to the surface, with 
much smaller tensile stresses in the interior.  For such cases, the uniform stress assumption is not 
reasonable or useful.  For a thick specimen, ASTM Standard Procedure E837 includes a test for 
the uniformity of the residual stresses being measured.  The methods specified in E837 can only 
be used if the residual stresses have been confirmed to be uniform.   

Over the years, several mathematical methods have been developed for calculating non-
uniform residual stresses in thick materials from hole-drilling measurements.  These methods 
seek to identify the interior residual stresses by considering the evolution of the strains measured 
as the depth of the drilled hole is gradually increased.  Because the strain measurements are 
made from strain gages attached to the specimen surface, the greatest sensitivity is to the residual 
stresses close to the surface.  Sensitivity rapidly reduces with depth.  At depths beyond about half 
the mean diameter of the hole-drilling rosette, sensitivity to the interior stresses completely 
disappears.   

This stress sensitivity variation makes it difficult to evaluate interior stresses reliably.  
Small errors in experimental measurements can cause much larger errors in calculated residual 
stresses.  This is a fundamental physical limitation of the hole-drilling method, not a 
mathematical artifact of any given stress calculation method.  The various mathematical methods 
use different approaches to minimize the adverse effects of experimental errors.  However, they 
all have to face the same trade-off between spatial resolution and stress uncertainty.  If good 
spatial resolution of the variation of residual stresses with depth is required, there will be 
substantial noise and uncertainty in the individual stress values.  On the other hand, if low 
sensitivity to experimental errors is required, spatial resolution has to be sacrificed.   

The three stress calculation methods used by H-DRILL span the range between low 
sensitivity to experimental errors and high spatial resolution of calculated residual stresses.  The 
three choices are: 
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• Uniform Stress Method.  This is the method specified in ASTM 837.  It assumes that the 
residual stresses are uniform with depth from the specimen surface.  Thus, the method 
has no spatial resolution at all.  However, when the measured residual stresses are 
actually uniform, this is the method of choice because it is the least sensitive to the 
effects of experimental errors.   

• Power Series Method.  This is a middle choice.  It provides a limited amount of spatial 
resolution by assuming that the residual stresses vary linearly with depth from the 
specimen surface.  The method is more sensitive to the effects of experimental errors than 
the Uniform Stress Method, but is a good choice when the measured residual stresses 
vary smoothly with depth.   

• Integral Method.  This method provides a separate evaluation of residual stress within 
each increment of depth used during the hole-drilling measurements.  Thus, the spatial 
resolution is the highest of the three calculation methods.  This is the method of choice 
when measuring rapidly varying residual stresses.  However, the sensitivity of the 
calculated stresses to small experimental errors is also the most severe.  The problem 
rapidly deteriorates if an attempt is made to increase spatial resolution by using many 
small hole-depth increments.   

 

The residual stresses calculated by H-DRILL reflect the experimental error sensitivity of 
the calculation method chosen.  The program can estimate the expected range that has a 90% 
probability of containing the actual stresses.  This calculation is based on user-supplied estimates 
of the likely errors in the various measured quantities.  The 90% probability bounds are realistic 
providing the supplied estimates of the measurement errors are realistic, and that an appropriate 
calculation method is chosen.   

Sensitivity to random experimental errors can be reduced by strain data smoothing.  
H-DRILL provides a method for including such smoothing.  However, it must be noted that 
smoothing also distorts the data and can lead to computational artifacts.  Thus, smoothing should 
be done with caution, and kept to an absolute minimum.  Smoothing has the largest effect on the 
Integral Method, and the least on the Uniform Stress Method.   

In general, the nature of the residual stresses being measured is not known in advance.  
Thus, the choice of calculation method or the amount of smoothing to be used is difficult to 
predict.  A good strategy is to try all three methods in reverse order (Integral, Power Series, and 
Uniform Stress) with zero smoothing.  Good engineering judgment, combined with a knowledge 
of the stresses expected, should then be used to choose the most appropriate calculation method 
and amount of smoothing for the given experimental data.  Similar engineering judgment is also 
essential when interpreting the meaning and reliability of the results obtained.   
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2.  USING  H-DRILL 

2.1  Getting Started 

The distribution disk contains the main program, the User’s Manual in Word format 
(.doc) and in Portable Document Format (.pdf), and five demonstration data files.  The files are 
packed into a self-extracting file “hd20setup.exe”, as follows: 

 
 H-Drill.exe H-DRILL program 
 H-Drill.doc User’s Manual in Word format 
 H-Drill.pdf User’s Manual in Portable Document Format 
 Demo0.dat Demonstration through-hole data 
 Demo1.dat Rendler and Vigness data [4] in US customary units 
 Demo2.dat Rendler and Vigness data [4] in metric units 
 Demo3.dat Demonstration data for linearly varying stresses 
 Demo4.dat Demonstration data for reversing stresses 
 

To install H-DRILL on your hard disk, put the distribution disk into your CD drive, and 
click the “Start” button (lower left of the screen window).  Then click “Run…”,  “Browse…” 
and the tab of the “Look in:” box.  Select the CD drive and then double-click “hd20setup.exe”.  
The H-DRILL files will then be copied to the hard disk and folder of your choice.  (The folder 
will be created if it does not already exist.)  Click  cdr  at upper right corner to close the Install 
window.   

To start H-DRILL, open the folder containing the program, and double-click 
its icon.  The icon schematically represents a hole-drilling rosette, and looks like this:  
If you will be using H-DRILL often, right-click H-Drill.exe, click “Create Shortcut” 
and then drag the shortcut icon to your desktop.   

H-DRILL can accept optional command line parameters to alter the way it starts.  Section 
5.1 describes how to make H-DRILL start with a specified screen resolution.  That section also 
describes how to make H-DRILL automatically read data files and do specified calculations.  
The required command line parameters can be added to the shortcut icon.  See Section 5.1 for 
further details.   
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When starting for the first time, H-DRILL displays the following dialog requesting some 
registration details.   

 

Please enter your company name and the serial number printed on the disk envelope.  The 
format of the serial number is xxxx-xxxx-xxxx where “x” are digits.  Click “OK” when ready. 

Registration is required only on the first use of H-DRILL after installation.  
Subsequently, on start-up, H-DRILL immediately displays its title window and pull-down menu 
options.  The display appears as follows:  
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2.2  Using the File Menu 

The “File” menu in the main window enables you to create, open, save and print your 
hole-drilling data, and to exit the program.  The options are : 

New... 

Open... 

Save 

Save As... 

Print... 

Exit 

 

2.2.1  Initializing H-DRILL for New Data 

Before starting work with a new set of data, H-DRILL needs to be initialized so that it 
starts with zero data.  Since this initialization erases any existing data, the previously specified 
data should first be saved using the “Save” or “Save As” options.  See Section 2.2.3 for details.  
When ready, click “New...” and the following dialog is displayed:   

 

Click “Inches” or “Metric” and then “OK’ to choose the measurement system required 
for the new calculation.  Clicking “Cancel” returns to the main menu without making any 
changes.  Before proceeding, H-DRILL checks whether there are any unsaved data from a 
previous calculation.  If there are, H-DRILL displays the following dialog:   
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Clicking “Yes” takes you to the “Save As...” dialog, where you can specify the file name 
for saving the existing data.  Clicking “No” allows the initialization to proceed without saving 
the existing data.  Clicking “Cancel” aborts the initialization process and returns you to the main 
menu without making any changes to the existing data.    

NOTE 1:  For user convenience, the material properties are initially set to correspond to a 
typical steel.  These properties can be changed subsequently, as needed.  See Section 2.3.1 for 
details.   

NOTE 2:  When H-DRILL first starts, it automatically initializes with US customary units.  If 
you wish to use these measurement units, it is not necessary to use “New...” before starting your 
first calculation.  However, “New...” is required before all subsequent calculations, even if you 
continue to use US customary units. 

 

 

2.2.2  Opening an Existing Data File 

Click “Open...” to read data previously saved in a file.  H-DRILL displays the following 
dialog:   

 

If the required data file is displayed in the dialog, click its name and then click “Open”.  
Alternatively, just double-click the file name.  The default file name is the input file name last 
chosen (if any).  If the file you require is in a different folder, click the yellow up-arrow to move 
up the directory tree.  Double-click the displayed folder names to move down the directory tree.   
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The “OPEN - Data File” dialog assumes that the required file name has an extension 
“.DAT”.  If your file has a different extension, click the “Files of type” window and then click 
“All Files (*.*)”.  The dialog will then display all files, not just those with “.DAT” extensions.   

If you enter a file name that H-DRILL cannot find, the program displays the following 
warning message.  Click “OK” to clear the dialog.   

 

Data read from a file overwrites and replaces all the data used in any previous 
calculation.  H-DRILL checks whether any data have previously been entered or changed.  If so, 
the program asks for a confirmation before proceeding to read new data from a file.  Click “Yes” 
if you wish to save the existing data.  H-DRILL then displays the “SAVE - Data File” dialog (see 
Section 2.2.3).  Click “No” if the existing data are not needed any longer, and can be erased.  
Click “Cancel” to abort the process and return to the main window without making any changes.  

After reading the data file, H-DRILL displays numerical and  graphical summaries of the 
data.  H-DRILL adjusts to the system of units used in the data file, either US customary or 
Metric units.  This specification of units supersedes any previous choice of units.   

If H-DRILL encounters any unexpected formatting in the input data file, it displays the 
following warning: 
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Click “OK” to clear the dialog.  Most likely, the chosen file is not an H-DRILL data file 
and does not contain valid hole-drilling data.  See Chapter 5 if you wish to prepare your own 
data files outside H-DRILL.   

 

 

2.2.3  Saving Data in a File 

You can save all existing input data by clicking either “Save” or “Save As...” in the 
“File” menu.  If you click “Save As...”, H-DRILL displays the following dialog :  

 

This dialog operates in the same way as the “READ – Data File” dialog described in 
Section 2.2.2.  If you wish to create a new file for your data, click the “File name” box, type the 
desired name and click “Save”.  To prevent accidental overwriting of any existing data, 
H-DRILL first checks to see if the specified file already exists.  If it finds an existing file of the 
same name, it displays the following dialog : 
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Clicking “Yes” replaces the data in the file with the current data in H-DRILL.  Clicking 
“No” returns you to the “SAVE – Data File” dialog so that you can change your file name 
choice.   

If you wish to update a file that is already open, click “Save” instead of “Save As...”.  
This updates the data in the file used in the last “Open...” or “Save As” action, whichever was the 
more recent.  It is not necessary to close a file after use.  H-DRILL does this automatically.   

 

 

2.2.4  Printing 

The currently displayed text or graph can be printed by first clicking any part of the 
desired window.  This action selects the chosen window, causing the heading to appear in blue 
and all other (non-selected) windows to have gray headings.  Click “Print...” in the “File” menu 
to open the Windows system “Print Setup” menu.  Click “OK” to start printing.   

 

 

2.2.5  Exiting 

When finishing work with H-DRILL, exit the program by clicking “Exit” in the “File” 
menu.  If you have any data that have not yet been saved to a file, H-DRILL asks whether you 
wish to save these data before exiting.   

 

Clicking “Yes” has the same effect as clicking “Save As...” in the “File” menu, and 
causes the “SAVE – Data File” dialog to be displayed.  Clicking “No” exits H-DRILL without 
saving the data.  Clicking “Cancel” returns you to the main window without any action.   

NOTE:  When finishing work with H-DRILL, it is good practice to exit by clicking “Exit” in the 
“File” menu.  It is also possible to exit the program by clicking  cdr  at the upper right corner of 
the main window.  However, this second method of exiting is not recommended because it closes 
H-DRILL immediately, before the program has a chance to check for unsaved data.  Thus, any 
data that were not previously saved in a file using “Save” or “Save As...” are lost.   
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2.3  Using the Through-Hole Menu 

A “Through-Hole” type of measurement is used when working with materials in the 
shape of a thin plate or sheet.  In this procedure, it is assumed that the residual stresses are the 
same throughout the material thickness.  This assumption may or may not be valid in practice.  
Neither ASTM E837-99 nor H-DRILL provide any means of checking this point.  If the uniform 
stress assumption is valid, then the Through-Hole calculation method can be used for thin plates 
or sheets where the material thickness does not exceed 0.4 times the mean diameter of the hole-
drilling rosette that is used.  Table 1 on the next page lists the maximum acceptable material 
thickness for Through-Hole measurements with the five available hole-drilling rosette types.   

The “Through-Hole” menu in the main window enables you to specify the data for a 
Through-Hole residual stress measurement.  The options are: 

Specify Material + Geometry... 

Specify Through-Hole Strains... 

Display Stresses 

Save Results... 

 

2.3.1  Specifying Material and Geometry 

This option allows you to enter details about the rosette type, specimen elastic properties 
and hole diameter.  When this option is selected, H-DRILL displays the following dialog:  
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The cursor starts in the first data box, "Data Title".  This box is available to store a short 
description in your own words to identify the current calculation.  H-DRILL will include this 
description in its calculated results and its data files.  You may use up to 50 characters.  

You can use the Tab key to move the cursor sequentially to all the data boxes and 
buttons.  Alternatively, you can use the mouse to reach any box or button directly.   

You can select the rosette type from among five options by clicking the buttons or rosette 
names.  These five rosette types correspond to those specified in ASTM E837-99.  The names 
correspond to their product numbers in the catalog published by Measurements Group, Inc., 
Raleigh, NC.  The RE rosettes correspond to the “Type A” design in ASTM E837-99, the UM 
rosette corresponds to “Type B”, and the RR rosette corresponds to “Type C”.   

You can enter the values for the data required in the boxes on the right side of the dialog 
by clicking the boxes and entering the numeric data.  The range of hole diameters accepted by 
H-DRILL follows the ranges specified in ASTM E837-99.  Table 1 summarizes the acceptable 
hole diameter ranges.   

Rosette Type  Max. Thickness Min. Hole Diameter Max. Hole Diameter 

031 RE 0.040”   (1.01mm) 0.024”   (0.61mm) 0.040”   (1.01mm) 

062 RE 0.081”   (2.05mm) 0.060”   (1.52mm) 0.100”   (2.54mm) 

125 RE 0.162”   (4.10mm) 0.132”   (3.35mm) 0.220”   (5.59mm) 

062 UM 0.080”   (2.02mm) 0.060”   (1.52mm) 0.100”   (2.54mm) 

030 RR 0.068”   (1.73mm) 0.060”   (1.52mm) 0.100”   (2.54mm) 

Table 1.   Acceptable ranges for material thickness and hole diameter  
for Through-Hole measurements.  (Adapted from ASTM E837-99 [1].) 

The two "Std. Error" quantities in the Material and Geometry Data dialog are optional.  If 
specified, they represent your estimates of the standard deviation of the errors in the Young's 
modulus and hole diameter values that you entered.  If your estimates are based on a large 
number of observations of measurement errors, the standard deviations equal the root mean 
square errors.  H-DRILL uses the error standard deviations when estimating the probability 
bounds of the calculated residual stresses, i.e., the bounds that have a 90% probability of 
containing the actual residual stresses.  If you enter zero or accept the zero default for all "Std. 
Error" quantities, H-DRILL omits estimating the probability bounds for the calculated stresses.   
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Click “OK” when you have finished entering the material property and geometry data.  
H-DRILL then checks the given data for consistency.  This does not mean that all data are 
correct or sensible, only consistent.  Thus, Young's Modulus should be greater than zero, and the 
hole diameter should be smaller than the inner diameter of the strain gage rosette pattern, etc.  If 
H-DRILL detects a data consistency error, it displays a message such as the following : 

 

In this case, a hole diameter of 0.8 inches was entered by mistake, instead of 0.08 inches.  
H-DRILL detected that the hole diameter should not exceed 0.100 inches for a 062 RE rosette, 
and gave the warning message.  Click “OK” to erase the message.  H-DRILL then returns to the 
“Material and Geometry Data” dialog, and allows you to adjust the given data.  Click “OK” in 
the “Material and Geometry Data” dialog after completing your changes.   

NOTE:  Clicking the “Cancel” button in any dialog causes H-DRILL to exit that particular 
dialog without doing or changing anything.  However, in the case of a sequence of dialogs, the 
cancellation applies only to the last dialog, and not to any of the previous dialogs, including any 
repetitions of the last dialog.  Thus, in the example above, the first click “OK” altered the data.  
This change in data is not undone by subsequent clicking of the “Cancel” button after responding 
to the error message.  For this reason, you should carefully check for possible changes in data 
after using the “Cancel” button in any but the first dialog of a sequence.   
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2.3.2  Specifying Strains 

This option allows you to enter measured strain data.  When this option is selected, 
H-DRILL displays the following dialog:  

 

This dialog allows you to enter the measured strain data.  The first line accepts the initial 
strains measured before a hole is drilled.  The second line accepts the final strains measured after 
the hole is drilled.  H-DRILL calculates the difference between the two sets of strain readings, 
and uses the resulting strain changes for its calculations.  Thus, perfect initial balancing of each 
strain gage bridge is not necessary.  However, you should try to avoid having substantial initial 
strains because they can hinder personal interpretation of the measurements, and thereby obscure 
potential errors.   

Use the "Std Strain Error" box to enter your estimate of the standard deviation of the 
errors in the given strain values.  If your estimate is based on a large number of observations of 
measurement errors, the standard deviation equals the root mean square error.  H-DRILL uses 
this value together with those for the modulus and hole diameter errors from the “Material and 
Geometry Data” dialog when estimating the probability bounds of the calculated residual 
stresses.  These bounds have a 90% probability of containing the actual residual stresses.  If you 
do not enter any "Std Error" quantity, H-DRILL omits estimating the probability bounds for the 
calculated stresses.   

Click “OK” to accept your given data.  H-DRILL can only do minimal consistency 
checking because a wide range of strain values is potentially acceptable.  Alternatively, click 
“Cancel” to abandon your given data and to return to the main menu without making any 
changes.   
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If H-DRILL finds no errors, it summarizes the input data as follows: 
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2.3.3  Calculating Through-Hole Stresses 

The “Display Stresses” option calculates and displays the residual stresses corresponding 
to the measured strain data for a through-hole measurement.  This calculation is appropriate for 
the case when the material thickness is less than the maximum values indicated in Table 1, and 
where the in-plane stresses are uniform through the material thickness.  H-DRILL calculates the 
residual stresses using the ASTM E837-99 procedure and displays the results in numerical form.   

 

The example results are from file  Demo0.dat.  The upper part of the display summarizes 
the rosette and material property input data.  The lower part of the display lists the measured 
strain data and the calculated residual stresses.   

Smax and Smin are the two principal stresses, and Beta is the angle measured clockwise 
from the direction of gage 1 to the direction of the maximum (most tensile) principal stress Smax.  
Tmax is the maximum shear stress that is present.  It acts in the directions midway between the 
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two principal directions.  S1 is the axial stress in the direction of gage 1, S3 is the axial stress in 
the direction of gage 3, and T13 is the in-plane shear stress in directions of gages 1 and 3.   

The middle of the three lines of stress results gives the calculated stresses corresponding 
to the given (smoothed) strain data.  The lines labeled "max" and "min" specify the stress range 
that has a 90% probability of containing the actual residual stresses [7].  This probability 
estimate is valid providing the existing residual stresses actually are uniform and the specified 
error standard deviations are realistic.  If the existing residual stresses actually are non-uniform, 
the "min" and "max" results are not valid, and may not contain the actual stresses at the 90% 
probability level.  The size of the probable stress range depends on the standard deviations of the 
various possible measurement errors.  Small measurement errors give narrower probable stress 
ranges.   

NOTE 1:  In general, the maximum shear stress, Tmax, numerically equals half the difference of 
the two principal stresses Smax and Smin.  However, this relationship does not hold for the stress 
values at the “max” and “min” probability bounds.  This behavior occurs because Tmax is defined 
as a positive number, while the sign of the difference of Smax and Smin can change.  Thus, on the 
“max” and “min” lines, Tmax has a minimum value of zero, and a maximum that accounts for the 
combination of the individual probability ranges of the two principal stresses Smax and Smin.   

NOTE 2:  Although they are conceptually similar, “Through-Hole” and “Blind-Hole” 
measurements require different calculation procedures.  The options in the “Through-Hole” and 
“Blind-Hole” menus are therefore not interchangeable.  All work with through-hole 
measurements should be done using the “Through-Hole” menu, and all work with blind-hole 
measurements should be done using the “Blind-Hole” menu.  H-DRILL displays appropriate 
warning messages if the options within the two menus are mixed.   
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2.3.4  Saving Results in a File 

The “Save Results” option does the same calculation as the “Display Stresses” option, but 
with the results saved in a file instead of being displayed on the screen.  H-DRILL displays a 
dialog to ask for the name of the results file: 
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2.4  Using the Blind-Hole Menu 

A “Blind-Hole” type of measurement is used when working with materials that are thick 
compared with the rosette size.  The material thickness should exceed 1.2 times the mean 
diameter of the hole-drilling rosette that is used.  Table 2 lists the minimum acceptable material 
thickness for Blind-Hole measurements with the five available hole-drilling rosette types.   

The “Blind-Hole” menu in the main window enables you to specify the data for a Blind-
Hole residual stress measurement.  The options are: 

Specify Material + Geometry... 

Specify Strains... 

Display Uniform Stresses 

Save Results... 

Display Power Series 

Save Results... 

Display Integral Method 

Save Results... 

 

2.4.1  Specifying Material and Geometry 

This option allows you to enter details about the rosette type, specimen elastic properties 
and hole diameter.  When this option is selected, H-DRILL displays the same dialog as shown in 
Section 2.3.1.  The procedure for data entry is the same as described in Section 2.3.1, except that 
the acceptable specimen thickness is governed by Table 2 rather than Table 1.   

 

Rosette Type  Min. Thickness Min. Hole Diameter Max. Hole Diameter 

031 RE 0.121”   (3.08mm) 0.024”   (0.61mm) 0.040”   (1.01mm) 

062 RE 0.242”   (6.16mm) 0.060”   (1.52mm) 0.100”   (2.54mm) 

125 RE 0.485”   (12.3mm) 0.132”   (3.35mm) 0.220”   (5.59mm) 

062 UM 0.242”   (6.16mm) 0.060”   (1.52mm) 0.100”   (2.54mm) 

030 RR 0.204”   (5.18mm) 0.060”   (1.52mm) 0.100”   (2.54mm) 

 
Table 2.   Acceptable ranges for material thickness and hole diameter  
for Blind-Hole measurements.  (Adapted from ASTM E837-99 [1].) 
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2.4.2  Specifying Strains 

This option allows you to enter measured strain data.  When this option is selected, 
H-DRILL displays the following dialog:  

 

H-DRILL enables you to enter measured relieved strain data for up to 25 hole depth 
increments.  Because of space limitations, the “Blind-Hole Strain Data” dialog only displays the 
data for ten hole depths.  The data for the other hole depths can be displayed and changed by 
dragging the “Scroll Strain Data” slider up or down as needed.   

The “Blind-Hole Strain Data” dialog includes an additional "baseline" set of strain data to 
record the indicated strains before hole drilling commences (Depth = .0000).  For its internal 
calculations, H-DRILL subtracts these baseline strains from all the other measured strains.  Thus, 
perfect initial balancing of each strain gage bridge is not necessary.  However, you should try to 
avoid having substantial baseline offset strains because they can hinder personal interpretation of 
the measurements, and thereby obscure potential errors.   

Relieved strain data entry is relatively free of restrictions.  The main requirement is that 
each set of three strains ε1, ε2 and ε3 must be correctly grouped with their hole depth value.  
However, you may specify the sets of hole depth and associated strains in any order and on any 
line.  The hole depths need not be ascending order and there may be unused lines among the 
specified data.  However, the baseline set of strains measured before you started hole drilling 
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must appear on line 0.  H-DRILL reserves line 0 for this baseline set, and it does not allow you 
to alter the zero hole depth specified on that line.   

The first two "Std Error" quantities on the right are your estimates of the standard 
deviations of the errors in the subsequent strain and hole depth values.  If your estimates are 
based on a large number of observations of measurement errors, the standard deviations equal 
the root mean square errors.  H-DRILL uses these values together with those for the modulus and 
hole diameter errors from the “Material and Geometry Data” dialog when estimating the 
probability bounds of the calculated residual stresses.  These bounds have a 90% probability of 
containing the actual residual stresses.  If you enter zero or accept the zero default for all "Std 
Error" quantities, H-DRILL omits estimating the probability bounds for the calculated stresses.   

The "Strain Smoothing" is a percent factor that allows you to smooth the measured strain 
data mathematically.  You may wish to do this to reduce the effect of random strain 
measurement errors on Integral Method stress calculations.  Strain smoothing has little effect on 
Uniform Stress and Power Series stress calculations because these two methods implicitly 
include substantial smoothing.  If used, a typical Strain Smoothing is about 10%.  

CAUTION:  Use strain smoothing sparingly and only when needed.  At the same time as 
providing some desirable smoothing, the process also slightly distorts the measured strain data.  
On exit from the "Strain Data" menu, check the graph in the “Strains” window to confirm that 
the smoothing is reasonable.  Adjust the amount of smoothing, if necessary.   

Since the data entry format is relatively free form, H-DRILL can do only minimal 
consistency checking of the data.  Thus, be careful to ensure that the entered data are accurate.  
The only checks H-DRILL can make are to ensure that strains at a non-zero hole depth are not 
identical to the baseline strains, and that the current hole depth is not the same as any other 
specified hole depth.  If you have specified a non-zero "Max Depth Error", H-DRILL considers 
two hole depth specifications to be the same if the difference between them is less than two times 
the "Max Depth Error".  For this reason, be careful about making large increases to the "Max 
Depth Error" after you have already specified the hole depths.  Previously acceptable hole depths 
may then be identified as being too close to other hole depths and it may be difficult to find 
acceptable depth values.  In general, you will have fewer than 25 sets of hole depth and relieved 
strain data.  When you have finished specifying the strain data, click “OK” to exit the dialog.  
H-DRILL then displays three windows summarizing the data you have specified, one in 
numerical form, and two in graphical form.  The illustrations on the next pages show typical 
examples of these windows.   
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The “Material and Geometry Data” window numerically summarizes all the given data.  
This window should be examined carefully to check for possible typing errors during data entry.  
The “Measured Strain” window presents the strain data in graphical form.  The data points 
indicate the specified strain data, and the solid lines indicate the smoothed strain values used for 
the stress calculation.  Adjust the "Strain Smoothing" if the solid lines are unrealistic.  When 
"Strain Smoothing" is zero, the solid lines pass through each of the data points.  The dashed lines 
in the graph represent the calculated strain values for the theoretical case where the residual 
stresses are uniform with depth from the specimen surface.  The dashed and solid lines should 
closely coincide when the actual stresses are uniform with depth.  Any significant deviation 
indicates stress non-uniformity or measurement error.   

The “Normalized Strain” window presents the given strain data in the normalized form 
specified by ASTM E837-99.  The upper, pale blue, line indicates the expected variation with 
hole depth of the strain quantity p = (ε3 + ε1)/2, expressed as a percentage of its value at hole 
depth = 0.4 D0.  The size of the rosette mean diameter, D0, is listed in the “Material and 
Geometry Data” window.  The lower line indicates the expected variation with hole depth of the 
strain quantities q = (ε3 – ε1)/2  and  t = (ε3 – 2ε2 + ε1)/2.  The data points indicate the percentage 
values of the specified strains.  If the principal strain directions are close to gage 1 and 3 
directions, then strain quantity q is bigger than strain quantity t.  In this case, the percentage 
values of q are plotted in purple.  Alternatively, if a principal strain direction is close to gage 2 
direction, then strain quantity t is bigger than strain quantity q.  In this case, the percentage 
values of t are plotted in green.   
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ASTM E837-99 uses the normalized strain graph as a method for checking whether the 
measured strains correspond to residual stresses that are uniform through the specimen depth.  If 
the percentage strain points are “close” to the expected curves, then the residual stresses can be 
assumed to be approximately uniform through the specimen depth.   

NOTE:  E837-99 does not specify how “close” the strain points should be to their corresponding 
expected curves.  A reasonable (but not officially sanctioned) rule of thumb is to require that the 
maximum deviation of the strain points from the expected curves should be less than a quarter 
the vertical distance between the two curves.  It should be noted that this test of residual stress 
uniformity is not a very sensitive one.  Even if the percentage strain points are “close” to the 
expected curves, significant residual stress non-uniformity can still exist [5].  The Power Series 
and Integral methods (see Sections 2.4.4 and 2.4.5) provide more sensitive measures of residual 
stress non-uniformity.   

You may return to the relieved strain dialog if you wish to modify the relieved strain 
data.  H-DRILL displays the previously specified data, sorted in order of increasing hole depth.  
Any unused intermediate lines are eliminated.  The relieved strain dialog has some convenient 
features to assist in manipulating the strain data.  You may permanently remove any line of strain 
data by setting the associated hole depth to zero, even if the associated strains are non-zero.  
H-DRILL erases the entire line after you click “OK”.  An exception is line 0, containing the 
baseline strains, which always refers to a zero hole depth.   

You may temporarily deactivate one or more lines of strain data by specifying the 
corresponding hole depths as negative values, e.g., a depth of 0.1" would appear as -.1000.  
H-DRILL stores the hole depth and strain data, but does not use them in its calculations.  You 
may reactivate the strain data by respecifying the corresponding hole depth as its original 
positive value.  Such data de/re-activation can be useful when doing stress calculations by the 
Integral method.  In such calculations, each line of strain data greatly influences the calculated 
stresses.  De/re-activation provides a convenient means of temporarily removing a line of strain 
data when assessing the influence of particular strain readings.   
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2.4.3  Calculating Uniform Stresses 

The “Display Uniform Stresses” option calculates and displays the residual stresses 
corresponding to the measured strain data, assuming that the stresses are uniform with depth 
from the specimen surface.  Providing that there is at least one active strain data set, H-DRILL 
then displays the following cascade of dialogs showing the input data and the calculated stresses 
in both numerical and graphical form.   

 

The top (visible) window in the cascade, “Calculated Stress”, numerically summarizes 
the input data and the calculated uniform residual stresses.  Any data or results that extend 
beyond the boundaries of the window can be scrolled up or down using the vertical scrollbar.  
The example results are from file  Demo1.dat.  The upper part of the window summarizes the 
rosette and material property input data, and the standard deviations of the four types of 
measurement errors, if present.  The lower part of the display lists the hole depth and measured 
strain data, and gives the calculated residual stresses.  H-DRILL uses an averaging method [6] to 
use all the relieved strain data, excluding those with hole depths specified as negative values.  
Thus, only one set of calculated stress results appears, even though there are typically several 
sets of relieved strain data.   
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Smax and Smin are the two principal stresses, and Beta is the angle measured clockwise 
from the direction of gage 1 to the direction of the maximum (most tensile) principal stress Smax.  
Tmax is the maximum shear stress that is present.  It acts in the directions midway between the 
two principal directions.  S1 is the axial stress in the direction of gage 1, S3 is the axial stress in 
the direction of gage 3, and T13 is the in-plane shear stress in directions of gages 1 and 3.   

The middle of the three lines of stress results gives the calculated stresses corresponding 
to the given (smoothed) strain data.  The lines labeled "max" and "min" specify the stress range 
that has a 90% probability of containing the actual residual stresses [7].  This probability 
estimate is valid providing the existing residual stresses actually are uniform and the specified 
error standard deviations are realistic.  If the existing residual stresses actually are non-uniform, 
the "min" and "max" results are not valid, and may not contain the actual stresses at the 90% 
probability level.  The size of the probable stress range depends on the standard deviations of the 
four types of measurement errors.  Small measurement errors give narrower probable stress 
ranges.   

NOTE:  In general, the maximum shear stress, Tmax, numerically equals half the difference of 
the two principal stresses Smax and Smin.  However, this relationship does not hold for the stress 
values at the “max” and “min” probability bounds.  This behavior occurs because Tmax is defined 
as a positive number, while the sign of the difference of Smax and Smin can change.  Thus, on the 
“max” and “min” lines, Tmax has a minimum value of zero, and a maximum that accounts for the 
combination of the individual probability ranges of the two principal stresses Smax and Smin.   

In the display, the residual stresses are labeled with a zero depth from the surface.  
However, these results should be interpreted as weighted averages for the entire hole depth.  The 
weighting occurs because the stresses close to the surface have a much greater influence than 
those at greater depths.  Thus, the displayed values mostly describe the stresses close to the 
surface, with only minor contributions from the interior stresses.  Stresses deeper than the "Stress 
depth limit" have almost no effect on the relieved strains.   

Clicking any window brings it to the top of the cascade and makes it visible.  Windows 
“Measured Strain” and “Normalized Strain” display the same strain vs. depth graphs that are 
shown after specifying strains using the “Specify Strains” option (see Section 2.4.2).  Windows 
“Maximum Principal Stress”, “Minimum Principal Stress” and “Max Shear Stress” display 
graphs of calculated principal and maximum shear stresses vs. depth.  The window below shows 
the maximum principal stress vs. depth graph.  The lines in the graph are horizontal because, by 
definition, the “Uniform Stress” calculation assumes that the stresses do not vary with depth 
from the surface.   
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NOTE  1:  The “uniform stress” calculation is only valid when the stresses are uniform with 
depth from the measured surface.  The calculation method does not itself provide an automatic 
means of assessing stress uniformity.  The graphs displayed in windows “Measured Strain” and 
“Normalized Strain” provide an approximate means of identifying stress non-uniformity.  If the 
dashed lines in the graphs are very close to the measured strains, then the stresses are likely to be 
reasonably uniform with depth.  However, these graphical comparisons are not very sensitive 
indicators of stress non-uniformity.  Stress uniformity can be assessed more reliably using the 
Integral method (see Section 2.4.5).   

NOTE  2:  For uniform stress calculations, it is best to use as many sets as possible of measured 
strain data.  A large amount of data enables the averaging method to operate effectively and 
minimize the effects of random errors.  The data should be distributed approximately uniformly 
throughout the hole depth.   
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2.4.4  Calculating Non-uniform Stresses by the Power Series Method 

The “Display Power Series” option calculates and displays the non-uniform residual 
stresses calculated using the Power Series method [8].  Providing that there are at least two 
active strain data sets, H-DRILL then displays a cascade of dialogs showing the input data and 
calculated stresses in both numerical and graphical form.   

 

The numerical display on top is similar to that for uniform stresses, except that it includes 
several lines of stress results, calculated at the hole depth increments up to the "Stress Depth."  
These stresses can vary linearly with depth.  If you specify non-zero measurement error standard 
deviations, the numerical results also include lines labeled "max" and "min" defining the stress 
range that has a 90% probability of containing the actual residual stresses [7].  This probability 
estimate is valid providing the existing residual stresses really do vary linearly with depth and 
the specified error standard deviations are realistic.  If the existing residual stresses are actually 
non-linear, the "max" and "min" results are not valid, and may not contain the actual stresses at 
the 90% probability level.  The size of the probable stress range depends on the standard 
deviations of the four types of measurement errors.  Small standard errors give narrower 
probable stress ranges.   



 33

Click the windows “Max Principal Stress”, “Min Principal Stress” and “Max Shear 
Stress” to view the profiles of these calculated residual stresses.  The diagram shows a typical 
calculated stress profile.   

 

The stress bounds have an X-shape, with a minimum width at a point about one third of 
the maximum active strain depth from the surface.  The minimum width does not occur at the 
halfway point because the measured strains are more sensitive to stresses close to the surface 
than to more remote stresses.   

The width of the stress probability bounds for the Power Series method increases with 
increasing depth from the surface and with decreasing number of hole depth increments.  
Because of this behavior, it is best to use many hole depth increments.  The Power Series method 
involves averaging, and a large amount of data enables the method to minimize the effects of 
random measurement errors.  This averaging behavior has a similar effect as strain data 
smoothing.  Therefore, strain data smoothing has little additional effect on Power Series residual 
stress calculations.   
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2.4.5  Calculating Non-uniform Stresses by the Integral Method 

The “Display Integral Method” option calculates and displays the non-uniform residual 
stresses calculated using the Integral method [8].  Providing that there is at least one active strain 
data set, H-DRILL displays the following cascade of dialogs showing the input data and the 
calculated stresses in both numerical and graphical form.   

 

The display is similar to that for the Power Series method.  However, here the specified 
depths are typically midway between the hole depth increments.  These values refer to the 
stresses within each increment rather than at the final depth of that increment.   

Click the windows “Max Principal Stress”, “Min Principal Stress” and “Max Shear 
Stress” to view the profiles of these calculated residual stresses.  The diagram on the next page 
shows a typical calculated stress profile.  
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If you specify non-zero measurement error standard deviations, the numerical results also 
include lines labeled "min" and "max" defining the stress range that has a 90% probability of 
containing the actual residual stresses [7].  This probability estimate is valid providing the 
specified error standard deviations are realistic.  

NOTE:  The format of the above residual stress vs. depth graph differs from that used by 
previous versions of H-DRILL.  When using the Integral method, the assumption is made that 
the stress within each hole depth increment is uniform.  Thus, one way of drawing the residual 
stress vs. depth graph is as a series of steps corresponding to the stresses within each of the hole 
depth increments.  This format, which is illustrated below left, was the one previously used.  
However, in cases where the steps are very irregular, the lines on the graph can overlap and 
become difficult to read.  To provide a clearer presentation, the graphical format has been  
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changed to the sloping lines shown above.  Typically, these lines pass through the midpoints of 
each hole depth increment.  To maintain stress equilibrium, the lines pass through the one-third  
points of the first and last hole depth increments.  The numerical results in the “Calculated 
Stresses” dialog, and the points in the stress graphs, refer to the mid-depths or one-third depths, 
as appropriate.  The graph at the right side overlays the two formats to illustrate the relationship 
between them.   

The width of the stress probability bounds for the Integral method increases with 
increasing depth from the surface and with decreasing hole depth increment thickness.  Because 
of this behavior, it is best to use only a few hole depth increments, say just four or five.  It is also 
desirable to increase the width of the depth increments with depth from the surface.  If necessary, 
some strain data can be deactivated by setting their hole depths as negative values.   

Alternatively, you can try strain smoothing to help reduce the scatter in the calculated 
stress values and the size of the associated stress probability bounds.  Such smoothing is most 
useful when there are more than five hole depth increments.  However, you should be careful to 
control the amount of smoothing so that you do not distort the strain data unrealistically.   

NOTE  1:  The hole-drilling method is mostly sensitive to residual stresses close to the measured 
surface.  Consequently, the method has only modest capabilities for identifying interior residual 
stresses.  The Integral method has the greatest capability to resolve fine detail.  However, it is 
seriously influenced by strain measurement errors.  The Power Series method is less influenced 
by strain measurement errors, but cannot resolve fine detail.  Even the Power Series method may 
not always be reliable.  Irrespective of the stress calculation technique used, meticulous 
experimental technique is essential to reduce the influence of strain measurement errors and 
allow useful residual stress calculations.  Engineering judgment should always be used to 
confirm that the calculated residual stresses are sensible.  

NOTE  2:  Because of the sensitivity of the hole drilling method to residual stresses close to the 
surface, the Integral method is limited to stress calculations for depths within 0.20 of the rosette 
mean diameter.  This active range is the same as for the Power Series method.  In the example 
case, the stress depth limit is 0.040".  H-DRILL omits strain data for greater hole depths in its 
calculations, as well as hole depths specified as negative values.   

 

2.4.6  Saving Results in a File 

The three “Save Results” options in the “Blind-Hole” menu do the same calculations as 
the adjacent stress calculation options, but with the results saved in a file instead of being 
displayed on the screen.  See Section 2.3.4 for further details.   
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2.5  Using the Graphics Menu 

The “Graphics” menu in the main window allows you to alter the screen resolution 
H-DRILL uses to display graphics.  The options are : 

 

640   x   480 Screen 

800   x   600 Screen 

1024  x  728 Screen 

1280 x 1024 Screen 

 

2.5.1  Setting the Screen Resolution 

The four options in the “Graphics” menu allow you to specify the area of the screen that 
H-DRILL occupies.  On start-up, H-DRILL detects the resolution of your computer screen, and 
adjusts the size of the main frame to fill the entire available area.  You may wish to confine 
H-DRILL to a smaller area of your screen, for example to leave other applications visible.  The 
screen resolution options provide that capability.  It may sometimes happen that H-DRILL does 
not correctly identify the resolution of your screen.  The screen resolution options can be used to 
make the needed adjustment.  If you need to use the screen resolution options on a regular basis, 
you may instead consider starting H-DRILL with command line parameters.  See Section 5.1 for 
further details.   
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2.6  Using the Window Menu 

The “Window” menu in the main window allows you to choose to view a particular 
window.  It also allows you to change the presentation format of multiple windows.  The options 
are : 

Size to Fit 

Cascade 

Tile 

Arrange Icons 

 

2.6.1  Selecting and Adjusting the Windows 

The options in the “Window” menu are useful for manipulating the presentation format 
of the results from a hole-drilling calculation, e.g., after using a choice from the “Calculate” 
menu.   

The “Size to Fit” option adds scrollbars to the currently chosen window, if that window is 
smaller than necessary to display the entire window contents.  The scrollbars allow you to scroll 
the window as needed to see all the window contents.   

The “Cascade” option arranges all open windows in a cascade, with their titles visible 
and in sequence.  You can then select any particular window by clicking its title or any other 
point in the window.   

The “Tile” option arranges all open windows in a tile pattern.  This allows you to view 
parts of all windows simultaneously.  You can use the usual window operations to manipulate 
the window display.   

The “Arrange Icons” option arranges the icons of all windows that have been minimized.   

Listed underneath the above options in the “Window” menu are the names of the open 
windows.  You can select any of those windows by clicking their names.   
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2.7  Using the Help Menu 

The “Help” menu in the main window provides access to summary information about the 
version of H-DRILL that you are using.  The one option is: 

About H-DRILL… 

 

2.7.1  About H-DRILL 

The “About H-DRILL…” option gives summary information about the version of 
H-DRILL that you are using.  This information includes the program version number, the 
software copyright notice, and your company name.  Click “OK” to return to the main window.   
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3.  EXAMPLE H-DRILL SESSION 

Double-click the H-DRILL icon to start the program.  Click “File”, “Open...”, 
“Demo1.dat” and “Open” to read an example data file.  H-DRILL displays three windows that 
summarize the input data both numerically and graphically.  Click “Blind-Hole” and “Display 
Integral Method” to calculate the residual stresses using the Integral method.  H-DRILL displays 
a cascade of windows showing the calculated results in both numerical and graphical form.  
Examine the contents of the various windows by clicking an exposed part of each window to 
bring that window to the top.   

Click “Blind-Hole” and “Save Results”.  Type “Demo1” and click “Save”.  This creates a 
file “Demo1.out” that contains the residual stress results computed by the Integral method.  
These results are identical to those displayed in the “Calculated Stresses” window after clicking 
“Display Integral Method”.   

Click “Blind-Hole” and “Specify Material + Geometry” to open the “Material and 
Geometry Data” dialog.  Click the “Poisson’s Ratio” box, alter the value from 0.282 to 0.6, and 
click “OK”.  H-DRILL identifies 0.6 as an unacceptable value, and displays a warning message.  
Click “OK” to return to the “Material and Geometry Data” dialog.  Change the Poisson’s ratio to 
0.3, and the data title to “Modified Rendler and Vigness Fig.13 data”.   

Click “Blind-Hole” and “Specify Blind-Hole Strains” to open the “Blind-Hole Strain 
Data” dialog.  Deactivate the strain data in line 2 by changing the sign of the hole depth to 
-0.0236.  Add the following hole depth and strain data to lines 9-11.  Use the “Scroll Strain 
Data” slider as needed.   

 Line 9.     .006    -13    –7     4 

 Line 10.    .018    –43   –20    13 

 Line 11.    .0295   –75   –30    21 

 Click “OK”.  Click the “Measured Data” window to view the new strain data.  Notice 
that the inactive strain at 0.0236 depth is not included in the strain vs. depth graph.  Click 
“Blind-Hole” and “Specify Blind-Hole Strains” again to return to the “Blind-Hole Strain Data” 
dialog.  Notice that H-DRILL has sorted the strain data into ascending order of hole depth.  The 
three new sets of strain data are now in lines 1, 3 and 5.  Click “Cancel” to exit the dialog 
without making any further changes.  Click “Display Integral Method” to repeat the Integral 
method calculations.  View the various windows.   

Click “File” and “Save Data As” to enter the “SAVE – Input File” dialog.  Change the 
filename from “Demo1.dat” to “Test1.dat” and click “Save”.  The modified data are then saved.   

Exit H-DRILL by clicking “File” and “Exit”.   
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5.  APPENDIX 

5.1 Command Line Parameters 

H-DRILL can accept command line parameters to alter the way in which the program 
starts.  These parameters can control the chosen screen resolution, the files used for input and for 
writing the calculated results, and the default use of inch or metric units.  To use command line 
parameters automatically, create a shortcut icon by right-clicking H-Drill.exe, and then select 
“Create Icon”.  Click the “Shortcut” tab and add the desired command line parameters at the end 
of the “Target:” line.   

 

5.1.1  Explicit Choice of Screen Resolution 

On start-up, H-DRILL detects the resolution of your computer screen, and adjusts the 
size of the main frame to fill the entire available area.  If you wish to confine H-DRILL to a 
smaller area of your screen, for example to leave other applications visible, you may use one of 
the following command line parameters: 

• s:640 makes H-DRILL start with a screen resolution of 640x480 pixels 

• s:800 makes H-DRILL start with a screen resolution of 800x600 pixels 

• s:1024 makes H-DRILL start with a screen resolution of 1024x768 pixels 

• s:1280 makes H-DRILL start with a screen resolution of 1280x1024 pixels 

It may sometimes happen that H-DRILL does not correctly identify the resolution of your 
screen.  The above command line parameters can be used to make the needed adjustment.  If 
more than one screen resolution parameter is specified, the last one is used.  Sequential position 
relative to any other command line parameters is not important.   
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5.1.2  Automatic Data Reading and Result Writing 

H-DRILL may be run from other programs in the form of a macro or batch file.  In such 
cases, it is desirable to run H-DRILL without any keyboard input.  The following command line 
parameters support this application: 

• r:filename reads input data from an existing file called filename 

• t:filename writes through-hole stress results to a new file called filename 

• a:filename writes average stress results to a new file called filename 

• p:filename writes power series stress results to a new file called filename 

• i:filename writes integral method stress results to a new file called filename 

• e exits from H-DRILL 

These command line parameters operate in the same way as the corresponding interactive 
commands.  They are processed in left-to-right sequence, and should be arranged in execution 
order, with r: first, followed by some combination of t:, a:, p: and i:.  All these parameters may 
be used repeatedly, providing that r: is used immediately before its associated stress calculations.  
Most commonly, the last parameter is  e  to exit H-DRILL.  However, this last parameter should 
be omitted if subsequent interactive input is desired.   

If H-DRILL encounters any errors while processing command line parameters, it requests 
corrections from the keyboard.  Typical errors include specification of an input file that doesn’t 
already exist, or a stress output file that does already exist.  After error correction, H-DRILL 
continues with command line parameter processing.   

A typical example is: 

 H-DRILL  r:demo1.dat 

Here, H-DRILL reads the input data from the existing file demo1.dat before going on to 
behave in the usual way.  This has the effect of preloading H-DRILL with the specified data.   

Another typical example is: 

 H-DRILL  r:demo2.dat  i:idemo2.out  a:ademo2.out  e 

Here, H-DRILL reads input data from the existing file demo2.dat, and writes Integral 
Method stress results in a new file idemo2.out, followed by average stress results in a new file 
ademo2.out.  The final “e” causes an exit from H-DRILL.   
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5.1.3  Default Specification of Measurement Units 

H-DRILL starts with a default choice of US customary units, i.e., inches, psi, etc.  This 
choice can be changed by using the “New” option in the “File” menu.  See Section 2.2.1 for 
details.  The same initializations can be done automatically on startup by using the following 
command line parameters:   

• m initializes H-DRILL operation to metric units 

• u initializes H-DRILL operation to US customary units 

When used with other command line parameters,  m  or  u  should appear after any  r: ,  
t: ,  a: ,  p: ,  or  i:  parameters.  This is because the last four parameters can change the default 
choice of units.  If more than one measurement unit parameter is specified, the last one is used.   
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5.2  Data File Format 

H-DRILL can read its input data in two different ways, either through the dialogs or 
through a data file.  Typically, data files are made by saving the data entered using the dialogs.  
However, it is also possible to create data files using either a text editor or another computer 
program.   

The data file  Demo1.dat  provides an example of the file format: 

 
            INCHES 
            Rendler and Vigness Fig.13 data  (US units)        
                     2     29.85      .282     .0610 
                     8         8         0 
                 .0000         0         0         0 
                 .0118       -26       -14         8 
                 .0236       -60       -25        17 
                 .0354       -85       -34        24 
                 .0472      -100       -38        31 
                 .0590      -109       -40        37 
                 .0708      -113       -40        41 
                 .0826      -114       -40        45 
                 .0944      -113       -38        45 
                     2     .0005     .0010       2.0 

Line 1 indicates the system of unit used in the file, either INCHES or METRIC.  Line 2 
contains the data title.  This title may be up to 50 characters long.  All subsequent lines contain 
numbers that are right justified in groups of ten columns.  Some of these numbers are decimal 
and some are integer.  Decimal points must not be added to the integer numbers, otherwise 
H-DRILL will fail unpredictably.   

The format of the data file follows that of the dialogs.  Line 3 specifies the rosette type, 
Young's modulus, Poisson's ratio and hole diameter.  Rosette types 1,2,3,4 and 6 correspond to 
031 RE, 062 RE, 125 RE, 062 UM and 030 RR respectively.  The rosette type number is also 
used as a code to distinguish Blind-Hole and Through-Hole data.  Positive values indicate Blind-
Hole data, while negative values (-1, -2, -3, -4, and -6) indicate Through-Hole data.   

Line 4 contains the number of lines of (non-initial) strain data that are present, the 
number of lines that have non-negative hole depth specifications, and the percent strain 
smoothing.  The subsequent lines contain the initial strain data followed by the strain data at the 
various hole depths.  The number of non-initial strain data lines must agree with the number 
specified on line 4.  The first number on each strain data line is the hole depth, and the remaining 
three numbers are the corresponding relieved strains ε1, ε2 and ε3.  The last line contains the 
estimates for the maximum errors in strain, hole depth, hole diameter and elastic modulus.   
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For Through-Hole calculations, the number of lines of non-initial strain data equals 1 (the 
“final strains.”)   “Hole Depth” is not used in this case, and is set to zero.   

CAUTION:  It is easy to make a mistake when externally preparing an input data file.  You 
should carefully check the data and graphs that H-DRILL displays after reading the data file.  In 
addition, you should get H-DRILL to check data consistency by choosing the “Specify Material 
+ Geometry” and “Specify Strains” options in the “Through-Hole” or “Blind-Hole” menus, and 
click “OK” in each dialog.   


